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QCFlow Product Support 

Digitech Systems, Inc. is committed to providing the best possible technical 
support for QCFlow and all of our products.  In order to get you the fastest, 
most complete, and most accurate support, please register your software.  
Registration ensures that you are eligible for the benefits available to 
registered users such as special offers, updates, and exclusive QCFlow 
information.  

Technical support is offered on an annual service contract basis.  You can 
reach Digitech Systems, Inc. toll-free technical support by calling (877)DSI-
FLOW (374-3569) between the hours of 8:00 AM and 5:00 PM Central Time 
or by e-mailing your request to support@dsiflow.com. 

 

 

mailto:support@dsiflow.com
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Chapter 1 – Installation 

Overview 
This chapter explains how to install QCFlow on your computer using the 
SETUP program.   

 

System Requirements 
• PC running Microsoft Windows 95/98/NT 4.0 (SP3 or higher)/2000  

• 32 MB memory minimum (64 recommended) 

• 40 MB available disk space for installation of program files 

• VGA or higher resolution monitor  

• CD-ROM drive 
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Running Setup 
Follow these instructions to run a full installation of QCFlow: 

1. Insert the QCFlow CD-ROM into a CD-ROM drive. 

2. Run SETUP.EXE from the CD-ROM. 
The Welcome screen appears. 

 

 
Figure 1-1:  Installation Welcome 
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3. Click Next to continue. 
The End-User License Agreement is displayed. 

 

 
Figure 1-2:  End-User License Agreement 
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4. Click Yes if you accept the terms of the license agreement. 
The Choose Destination screen appears. 

 

 
Figure 1-3:  Choose Destination 
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5. Select where you want to install QCFlow, then select Next. 
The Select Program Folder screen appears. 

 

 
Figure 1-4:  Select Program Folder 
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6. Select the Program Folder to install to, then select Next. 
The program will finish the installation of all necessary files and prompt 
you when the setup is completed.  Finally, you will be prompted to reboot 
your computer. 

 

 
Figure 1-5:  Setup Complete 

 

7. It is highly recommended that you restart your computer now.  Select 
Finish. 
After your computer has restarted, connect your QCFlow dongle key to the 
parallel port (printer port) of your computer.  You can still use a printer as 
normal when plugged into the QCFlow dongle key.  Your QCFlow system 
is now ready. 
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Uninstalling QCFlow 
Uninstalling QCFlow is a very simple process.  Every installation of QCFlow 
comes with an Uninstall program. 

1. Open the Windows Control Panel 

2. Select the Add/Remove Programs applet. 

3. Select QCFlow and click Add/Remove. 
The uninstall operation will remove QCFlow from the system.  However, 
any user generated data (processed files, databases, images, etc.) will be 
left intact for safety purposes. 
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Chapter 2 – Starting to use QCFlow 

Overview 
This chapter explains the basic procedures that you must know in order to start 
and exit QCFlow.  In this chapter, you will learn: 

• How QCFlow Operates 

• How to start and exit QCFlow 

• How to use the Data Group Manager 

• Accessing On-Line Help 

• Launching PaperFlow and OCRFlow from within QCFlow 

 

How QCFlow Operates 
QCFlow allows both automated and manual image manipulation and quality 
control operations on both images and indexes contained in data groups that 
were created with PaperFlow.  QCFlow operations can be divided into three 
subsets: 

• Automated Image QC:  Performs automated functions such as file size 
detection, image size detection, and document page count. 

• Index QC:  Performs functions such as index field verification, numeric 
sequence verification, insert/remove leading zeros, strip leading/trailing 
characters, and search and replace. 

• Manual Image QC:  Allows an operator to manually QC images, 
performing functions such as full-page/thumbnail image viewing, rotation, 
deletion, document break insertion/removal, page/document tags, and 
moving pages. 

 

These operations can be executed in any order.  QC operations are generally 
performed in full after a data group has been scanned and indexed.  However, 
you can perform the operations on a partial basis, and pick up where you left 
off.  
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Starting QCFlow 
To start QCFlow: 

1. From the QCFlow program group, click the QCFlow icon. 
If this is the first time QCFlow has been run on this computer, you will be 
prompted for a Central Project database location.  Your Central Project 
databases are a central location on your network for holding all customer 
and project information that will be configured later.  If you are using 
multiple computer systems, use the same location for all of your systems 
to eliminate copying customer and project information between those 
systems. 

 

 
Figure 2-1:  Select Central Database Location 
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2. Select the database location where a database already exists or where 
you would like to create a new Central Project database. 
After a database location has been selected, if QCFlow cannot locate an 
existing database, you will be prompted to create a new one.  After the 
database has been created, the Login prompt will be displayed. 

 

 
Figure 2-2:  QCFlow Login 

 

3. Enter your User Name and Password and select OK. 
Note:  If this is the first time you have run QCFlow or created new Central 
Project databases, the default User Name is “ADMIN” and the password is 
also “ADMIN”.  It will be important to change these in the future to ensure 
strict security measures.  Passwords are case-sensitive. 

Every time QCFlow is started, the Data Group Manager is displayed, 
showing a list of data groups that are available to be opened. 

 

 
Figure 2-3:  Data Group Manager 

4. Select the desired data group, or simply select Close if you do not wish 
to open a data group at this time. 
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Using the Data Group Manager 
Whenever a new data group is created in PaperFlow (DSI’s document capture 
software) or an unlisted data group is opened, the item will be added to the 
Data Group Manager.  You can open the data group manager by selecting 
Open Data Group from the Data Group menu of the main screen.  When the 
Data Group Manager is opened, it automatically queries all of the data groups 
that exist in its database to ensure that they still exist.  In other words, the Data 
Group Manager only shows a list of valid data groups.  The Data Group 
Manager offers the functions of opening a data group, adding an existing data 
group to the list (“Locate”), or permanently deleting a data group and all of its 
images and databases from the system (“Purge”). 

Opening a Data Group 
To open a listed data group: 

1. Highlight the desired data group by selecting the item with your 
mouse or using the up and down arrow keys on your keyboard. 
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2. Select Open. 
Or 

Highlight the desired data group by selecting the item with your 
mouse or using the up and down arrow keys on your keyboard.  Then, 
hit the space bar on your keyboard. 
Or 

Double-click on the desired data group. 
If the data group has only one project, that project will automatically be 
opened.  However, if more than one project exists in the data group, you 
will be prompted to select the project that you wish to work in. 

 

 
Figure 2-4:  Project Selection 

 

3. Select the desired project to open by highlighting the project with 
your mouse and clicking on Select (or by double-clicking the project). 
QCFlow will open the project, reading in all of the project settings, and 
will display the first page of the first document (if any documents exist). 
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Locating a Data Group 
You can add an existing data group (whether it resides on your computer or on 
another computer on the network) to your data group list by locating it.  To 
locate a data group: 

1. From the Data Group Manager, select Locate. 
The Locate Data Group screen is displayed. 

 

 
Figure 2-5:  Locate Data Group 

 

2. Select the DATAGRP.MDB database file for the data group that you 
wish to have added to your list and select OK. 
The data group will be added to the list. 

Removing an Item from the List 
Data Groups can be removed from the data group list.  This is often done to 
prevent operators from opening the incorrect data group.  Removing a data 
group from the list does NOT delete any information from the system.  The 
data group can later be re-located to add it back to the list.  To remove a data 
group from the list: 

1. Using your mouse or the up and down arrow keys, select the data 
group you wish to remove. 

2. Select Remove Item. 
QCFlow will prompt you to ensure that you wish to remove the data group 
from the list. 
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Purging a Data Group 
Data Groups and their associated images and databases can be permanently 
removed from your system (or the network) by using the purge operation.  
Once the information is purged, it cannot be recovered unless you have a 
backup of the information residing elsewhere.  Because of this data 
destruction capability, only administrators have the option of purging data 
groups.   

When a data group is purged, it automatically saves both the data group’s 
Productivity report and the Summary report.  These reports can be located at 
C:\Program Files\Digitech Systems\Common Files\Reports after the data 
group is purged. 

To purge a data group: 

1. Using your mouse or the up and down arrow keys, select the data 
group you wish to purge from the Data Group Manager. 

2. Select Purge. 
You will be prompted twice to ensure that you are absolutely sure that you 
wish to delete the information. 

3. Select Yes twice to permanently delete the data group. 
Once the data group has been purged, it will also be removed from the data 
group list in the Data Group Manager. 
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Figure 2-6:  QCFlow Main Screen 

 

On-Line Documentation 
You can access QCFlow’s on-line documentation, by selecting On-Line 
Documentation from the Help menu.  This documentation is provided in 
Adobe PDF format and requires a PDF viewer.  If you do not have the Adobe 
PDF viewer installed, you can install it from the QCFlow installation CD-
ROM. 
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Launching PaperFlow and OCRFlow 
You can launch PaperFlow and OCRFlow directly from within QCFlow if the 
applications have been installed on your computer.  This can be accomplished 
by simply selecting Launch PaperFlow or Launch OCRFlow from the Data 
Group menu.  If a data group is currently opened in QCFlow, it will 
automatically be opened in PaperFlow or OCRFlow. 

 

Exiting QCFlow 
As with any Windows-based software, it is extremely important to properly 
exit QCFlow.  Properly exiting ensures that files are kept intact and that 
system settings are properly saved.  Never power off your system while 
Windows is running as it may cause system corruption.  To properly exit 
QCFlow: 

1. From the Data Group menu, select Exit (or press Alt + F4). 
Upon exiting, QCFlow will save the system settings and close the data group 
images and databases that are being accessed. 
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Chapter 3 – Performing Automated Image QC 

Overview 
QCFlow offers automated QC operations that can greatly increase QC 
accuracy and productivity.  When the automated process is run, the following 
functions are performed on each document: 

1. Ensure that at least one page exists in the document.  If no pages exist, the 
document is tagged for access within PaperFlow. 

2. Ensure the image file for page 1 of the document can be located. 

3. Verify that the image file size for page 1 falls within the specified 
parameters. 

4. Ensure that the image file for page 1 can be opened (verifying that the 
image is good). 

5. Verify that the image for page 1 falls within the specified height and width 
(in pixels) parameters for any Image Size Verification Rules that 
encompass the page. 

6. Repeat steps 2 through 5 for any remaining pages within the document. 

7. Ensure that at least one page exists in the document (as done in step 1).  
This is in case pages were deleted during steps 2 to 6. 

8. Verify that the number of pages within the document falls within the 
specified Document Page Count parameters. 
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Configuring Automated Image QC 
Configuring automated image process is easily achieved.  All processing 
settings are automatically saved on a Customer/Project level.  In other words, 
when you open another data group for the same customer, with the same 
project, the settings will be restored. 

 

 
Figure 3-1:  Run Automated Image Processes 

 

Image File Size 
Checks the actual image files (i.e. 00000001.TIF) to ensure that the size of the 
file falls within the specified parameters.  Minimum specifies the minimum 
acceptable file size in Kbytes.  Maximum specifies the maximum acceptable 
file size in Kbytes.  If the Delete Pages Automatically option is selected, any 
images that do not fall within the specified parameters will automatically be 
permanently deleted from the document.  If this option is not selected, the 
pages will be tagged for review within PaperFlow. 
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Document Page Count 
Checks to ensure that the document contains the correct number of pages.  
Minimum and Maximum specify the acceptable range for number of pages 
within a document.  Any document whose page count falls outside of this 
range will be tagged for review within PaperFlow. 

 

Image Size Verification Rules 
Provides a list of rules that specify the minimum and maximum acceptable 
height and width of any pages within the document.  Multiple rules can be 
created.  This is particularly useful if page 1 of a document contains a unique 
sized piece of paper, with uniform sized pages behind it.  The image sizes are 
specified in terms of Pixels.  You can view the height and width of an image 
in Pixels from the Image Information option under the View menu or by 
viewing the properties of the file from the Windows® Explorer. You can also 
calculate the approximate width or height of an image by multiplying the 
original size of the sheet (in inches) times the resolution that the image was 
scanned in at.  For example, for an 8 ½ by 11 piece of paper scanned at 200 
DPI: 

 8.5  X 200 = 1700 pixels wide 11 X 200 = 2200 pixels high 

If the Delete Pages Automatically option is selected, any images that do not 
fall within the specified parameters will automatically be permanently deleted 
from the document.  If this option is not selected, the pages will be tagged for 
review within PaperFlow.   
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To create an image size verification rule: 

1. From the Run Automated Image Processes screen, select the Add 
button under Image Size Verification Rules.   
The Image Size Verification screen is displayed. 

 

 
3-2:  Image Size Verification Screen 

 

2. Enter the desired rule criteria.  Leaving a value of zero for a setting 
will cause that portion of the rule not to be verified (i.e. setting 
Minimum and Maximum Width to zero will cause the width not to be 
checked). 

3. Select the OK button. 
The new rule will be listed in the Image Size Verification Rules list. 

 

Reset Status 
As QCFlow performs automated image processing, it tags each document as 
having been processed.  Then when QCFlow starts processing again, it only 
processes documents that have not been processed.  This option allows you to 
“un-tag” those documents so they will be re-processed. 
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Starting the Automated Image QC Process 
To start the Automated Image QC Process: 

1. From the Data Group menu, select Automated Image QC. 
The Run Automated Image Processes Screen is displayed. 

2. Enter any processing criteria that you wish to have applied to the 
documents. 

3. Select the Start button. 
The QC Processing screen will be displayed, showing the status of the 
processes as they are run. 

 

 
Figure 3-3:  QC Processing 

 

After the automated process is complete, an error log is created listing all 
of the processing errors that occurred. You can view the actual processing 
errors in the processing logs described in Chapter 7 – System Logs. 
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Chapter 4 – Index QC 

Overview 
QCFlow’s Index QC operations allow operators to perform operations that 
allow for index field value quality control.  Index QC also allows users to 
search for and display lists of documents. 

 

Index QC Operations 
Index QC operations perform a specified function on a specified field across 
all of the documents within the project. 

 

 
Figure 4-1:  Index QC Operations 
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Check for Indexing Errors 
Checks the specified field for any indexing errors that may have occurred (i.e. 
blank fields, invalid dates or numbers, values that don’t meet the specified 
field mask, etc).  The same checks that are performed when saving index 
values within PaperFlow are performed during this operation. Any indexing 
errors are automatically tagged for review within PaperFlow.   

As an added bonus, all values are automatically reformatted to meet the field 
format and field mask criteria.  This is particularly useful if you indexed all of 
the documents with “mmm dd, yyyy” as the date format and later decided to 
change it to “mm/dd/yyyy”.  By running the Check for Indexing Errors 
operation, the field format will automatically be changed for all documents. 

 

Check Numeric Sequence 
This operation will look for the smallest and largest values for the specified 
field.  It will then query the database to ensure that each value between the 
largest and smallest values exists.  Any values that cannot be found will 
automatically be written out to the log files.  Information on viewing these log 
files can be found in Chapter 7 – System Logs. 

 

Insert/Remove Leading Zeros 
This will either pad the index values with leading zeros to create index values 
of a specified length, or remove all of the leading zeros from the index values. 

 

Search and Replace Characters 
This allows you to search for a specific value within an index field value and 
replace it with specific text.  The search operation automatically searches for 
any portion of the value containing the specified text.  Searching for “123” 
will replace “123” in index values “123ABC”, “A123BC”, and “ABC123” 
with the specified replacement text.  Both the Search For and Replace With 
values can be left blank.  If the Search For value is left blank, any index fields 
that are unindexed (i.e. left blank), will be replaced with the specified 
replacement text.  If the Replace With value is left blank, any occurrences of 
the Search For text will simply be removed from the index field.  Also, if the 
Search For text is specified as an asterisk (“*”), ALL VALUES, regardless of 
whether they are indexed or blank, will be replaced with the replacement text. 
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Strip Leading/Trailing Characters 
This will remove the specified number of leading characters and the specified 
number of trailing characters from each index value. 

 

Running Index QC 
To perform an Index QC Operation: 

1. From the QCFlow Main Screen, select Index QC in the Data Group 
menu. 
The Index QC Operations Screen is displayed. 

2. Select the index field that you wish to process. 

3. Select the Task that you wish to run. 

4. Enter any Task-Specific settings. 

5. Select the Start button to begin the process. 
After the process has been run, QCFlow will display a message showing 
what was updated. 
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Searching for Documents 
There may be times when it is necessary to locate a document based on its 
index values or to view a list of document index values.  This is done through 
the Index QC Search Criteria screen.  

You can navigate through the list of documents in your search results by 
selecting a document from the Search Results screen.  Then, when you move 
forward and backwards through documents, you will actually be moving 
forward and backwards through the list of documents that met your search 
criteria.  If you wish to cancel that navigation and return to navigating the 
entire project in the data group, you can simply close the search results screen 
without opening a document.  

 

 
Figure 4-2:  Index QC Search Criteria  
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Finding a Document 
To find a document: 

1. From the QCFlow Main screen, select Index QC from the Data Group 
menu. 
The Index QC Operations screen will be displayed. 

2. Select the Search Criteria tab. 
The Index QC Search Criteria screen will be displayed. 

3. Enter the search criteria for each field in the Search Value field.  You 
can enter values in multiple fields and select a Search Type of “And” 
(if you want the criteria to be met for all filled in fields), or “Or” (if 
you want the criteria to be met for any of the filled in fields).  You can 
use the wildcard character “*” (asterisk) to represent any length of 
multiple characters, or enter “[BLANK]” to search for blank values.  
For instance if you wish to find all documents beginning with a 5 and 
ending with a 9, you could simply enter 5*9 to locate the documents. 

4. Select the field that you wish to have the results sorted by in the Sort 
By field. 
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5. Hit Enter to perform the search or select Search with your mouse. 
QCFlow will search the database and display the Index QC Search Results 
screen, listing the documents that meet the criteria. 

 

 
Figure 4-3:  Index QC Search Results 

 

6. Select the document you wish to display by double clicking on the 
item with your mouse, or by using the up and down arrow keys, and 
pressing Enter (or the Spacebar). 
The first page of the selected document will be displayed in the QCFlow 
main screen. 

 

Clearing the Search Criteria 
You can quickly clear the search criteria by selecting Clear in the Search 
Criteria screen, rather than moving between fields and deleting the text. 
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Printing a List of Search Results 
You can print a list of selected search results.  To print the results list: 

1. Perform a search (as previously described in Finding a Document) 
that will display a list of documents including documents that you 
wish to print a listing for. 

2. While holding down the Ctrl or Shift key, left-click on the items in the 
list that you wish to print. 

3. When all desired items are selected, choose Print List. 
QCFlow will prompt you for the appropriate printer. 

4. Select the printer and choose OK. 
The selected list items will be printed. 

 

Saving a List of Search Results 
You can save a list of selected search results.  To save the results list: 

1. Perform a search (as previously described in Finding a Document) 
that will display a list of documents including documents that you 
wish to save a listing of. 

2. While holding down the Ctrl or Shift key, left-click on the items in the 
list that you wish to save. 

3. When all desired items are selected, choose Save List. 
QCFlow will prompt you for the file name. 

4. Select the file and choose Save. 
The selected list items will be saved. 
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Chapter 5 – Manual QC Operations 

Overview 
QCFlow offers extensive functionality to allow you to move between 
documents and pages, manipulate documents and pages, and tag items for 
cleanup within PaperFlow. Most of these operations can be performed in 
either full-page mode or in thumbnail mode. 

 

 
Figure 5-1:  Full-Page Mode 
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Figure 5-2:  Thumbnail Mode 

Note that when in thumbnail mode, blue markers indicate document breaks, 
red markers indicate missing images, and white markers with an “X” through 
them indicate unreadable images. 

You can switch between Full-Page and Thumbnail mode by double-clicking 
on an image of by selecting the mode from the View – Image View menu item. 
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Moving Between Documents and Pages 
Document and page navigation capabilities are available through hotkeys, 
menu selections, and toolbar buttons.   

Advance Forward 
Use:  Displays the next page (or thumbnail view of pages) that would be 
displayed if using the Auto-Display feature. 

Accessible From:  Data Group menu 

Display Mode Availability:  Full-Page and Thumbnail 

Hotkey:  Enter 

Toolbar Icon:   

Reverse Backwards 
Use:  Displays the previous page (or thumbnail view of pages) that was 
previously displayed. 

Accessible From:  Data Group menu 

Display Mode Availability:  Full-Page and Thumbnail 

Hotkey:  Ctrl+Enter 

Toolbar Icon:   

First Document 
Use:  Displays the first page of the first document in the current project. 

Accessible From:  View-Document menu 

Display Mode Availability:  Full-Page and Thumbnail 

Hotkey:  Ctrl+Home 

Toolbar Icon:   

Previous Document 
Use:  Displays the first page of the previous document in the current project. 

Accessible From:  View-Document menu 

Display Mode Availability:  Full-Page and Thumbnail 

Hotkey:  Ctrl+Page Up 

Toolbar Icon:   
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Jump to Document 
Use:  Allows you to jump to a specific document within the current project.   

Accessible From:  View-Document menu 

Display Mode Availability:  Full-Page and Thumbnail 

Hotkey:  Ctrl+J 

Toolbar Icon:   

Next Document 
Use:  Displays the first page of the next document in the current project. 

Accessible From:  View-Document menu 

Display Mode Availability:  Full-Page and Thumbnail 

Hotkey:  Ctrl+Page Down 

Toolbar Icon:   

Last Document 
Use:  Displays the first page of the last document in the current project. 

Accessible From:  View-Document menu 

Display Mode Availability:  Full-Page and Thumbnail 

Hotkey:  Ctrl+End 

Toolbar Icon:   

First Page 
Use:  Displays the first page of the current document. 

Accessible From:  View-Page menu 

Display Mode Availability:  Full-Page Only 

Hotkey:  Home 

Toolbar Icon:   
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Previous Page 
Use:  Displays the previous page of the current document. 

Accessible From:  View-Page menu 

Display Mode Availability:  Full-Page Only 

Hotkey:  Page Up 

Toolbar Icon:   

Jump to Page 
Use:  Allows you to specify the page number within the current document that 
you wish to display. 

Accessible From:  View-Page menu 

Display Mode Availability:  Full-Page Only 

Hotkey:  J 

Toolbar Icon:   

Next Page 
Use:  Displays the next page of the current document. 

Accessible From:  View-Page menu 

Display Mode Availability:  Full-Page Only 

Hotkey:  Page Down 

Toolbar Icon:   

Last Page 
Use:  Displays the last page of the current document. 

Accessible From:  View-Page menu 

Display Mode Availability:  Full-Page Only 

Hotkey:  End 

Toolbar Icon:   
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Image Information 
Use:  Displays the full path of the currently displayed image, as well as the 
size of the file. 

Accessible From:  View menu 

Display Mode Availability:  Full-Page Only 

Hotkey:  I 

Toolbar Icon:  None 

 

Image Viewing 
Zooming on Images 

QCFlow offers an intuitive method of zooming on images.  While in Full-
Page mode, use your left mouse button to draw a box around the region that 
you wish to zoom in on and release the mouse button.  QCFlow will zoom in 
on the exact region that you designated. 

Scale to Height 
Use:  Scales the image to the height of the QCFlow main screen. 

Accessible From:  View menu 

Display Mode Availability:  Full-Page Only 

Hotkey:  H 

Toolbar Icon:   

Scale to Width 
Use:  Scales the image to the width of the QCFlow main screen. 

Accessible From:  View menu 

Display Mode Availability:  Full-Page Only 

Hotkey:  W 

Toolbar Icon:   
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Scale to Window 
Use:  Selects the best method (scale to height vs. scale to width) to fit the 
entire image within the QCFlow main screen. 

Accessible From:  View menu 

Display Mode Availability:  Full-Page Only 

Hotkey:  None 

Toolbar Icon:   

Rotate 
Use:  Rotates the image in 90 degree increments for viewing purposes only.  
The rotation is not saved until the image is resaved. 

Accessible From:  View menu 

Display Mode Availability:  Full-Page Only 

Hotkey:  R 

Toolbar Icon:   

Full-Size Image 
Use:  Displays a full-size image of the selected thumbnail. 

Accessible From:  View menu 

Display Mode Availability:  Thumbnail Only 

Hotkey:  Spacebar 

Toolbar Icon:  None 

 

Page Manipulation 
Delete Pages 

Use:  Deletes the current displayed page in Full-Page mode or all selected 
pages in Thumbnail mode. 

Accessible From:  Edit menu 

Display Mode Availability:  Full Page and Thumbnail 

Hotkey:  Delete 

Toolbar Icon:   
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Resave Page 
Use:  Resaves the current page with the current rotation. 

Accessible From: Edit menu 

Display Mode Availability:  Full-Page Only 

Hotkey:  V 

Toolbar Icon:   

Rotate and Save Pages 
Use:  Rotates the selected pages and automatically resaves them. 

Accessible From:  Edit menu 

Display Mode Availability:  Thumbnail Only 

Hotkey:  R 

Toolbar Icon:   

 

Document Manipulation 
Delete Documents 

Use:  Deletes the current displayed document in Full-Page mode or all 
selected documents in Thumbnail mode. 

Accessible From:  Edit menu 

Display Mode Availability:  Full-Page and Thumbnail 

Hotkey:  Ctrl+Delete 

Toolbar Icon:   

Insert Break 
Use:  Inserts a document break prior to the current selected page, making the 
current page the first page of a new document. 

Accessible From:  Edit menu 

Display Mode Availability:  Full-Page and Thumbnail 

Hotkey:  Ctrl+Insert 

Toolbar Icon:   
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Remove Break 
Use:  In Full-Page mode, this merges the current document’s pages with those 
of the previous document.  In Thumbnail mode, this removes the selected 
document break (blue indicator), merging the two documents together. 

Accessible From:  Edit menu 

Display Mode Availability:  Full-Page and Thumbnail 

Hotkey:  Ctrl+R 

Toolbar Icon:   
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Moving Pages Between Documents 
QCFlow offers the ability to move pages between documents.  These pages 
can be selected from multiple documents and moved to a single document.  
Pages are never removed from their original documents until they are actually 
pasted to their destination document. 

 

Moving Pages in Thumbnail Mode 
To move pages in thumbnail mode: 

1. While in thumbnail mode, hold down the Ctrl key and click on the 
pages you wish to move (or use the Shift key to select a range of 
pages). 

2. Chose Select Pages for Move from the Edit menu, click the  icon on 
the toolbar, or hit Ctrl+C on your keyboard. 
If pages have already been tagged, but haven’t been pasted, QCFlow will 
prompt you to either replace or add to the current list of selected pages as 
shown below. 

 

 
Figure 5-3:  Select Pages for Move 

 

3. Select Add to List to add the pages to the current list, Replace List to 
remove all pages from the list and only add the current selected pages, 
or Cancel to cancel the operation. 

4. Repeat steps 1 to 3 for any remaining pages that you wish to move. 

5. Locate the document that you wish to paste the pages into and select 
the page before which the selected images should be inserted. 

6. Select Paste Selected Pages from the Edit menu, click the  icon on 
the toolbar, or hit Ctrl+V on your keyboard. 
QCFlow will prompt you to ensure this is where you wish to paste the 
selected pages. 

7. Select Yes to paste the pages. 
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Moving Pages in Full-Page Mode 
To move pages in full-page mode: 

1. While in full-page mode, locate a page that you would like to move. 

2. Chose Select Pages for Move from the Edit menu, click the  icon on 
the toolbar, or hit Ctrl+C on your keyboard. 
If pages have already been tagged, but haven’t been pasted, QCFlow will 
prompt you to either replace or add to the current list of selected pages as 
shown below. 

 

 
Figure 5-4:  Select Pages for Move 

 

3. Select Add to List to add the page to the current list, Replace List to 
remove all pages from the list and only add the current selected page, 
or Cancel to cancel the operation. 

4. Repeat steps 1 to 3 for any remaining pages that you wish to move. 

5. Locate the document that you wish to paste the pages into and find 
the page before which the selected images should be inserted. 

6. Select Paste Selected Pages from the Edit menu, click the  icon on 
the toolbar, or hit Ctrl+V on your keyboard. 
QCFlow will prompt you to ensure this is where you wish to paste the 
selected pages. 

7. Select Yes to paste the pages. 
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Using Auto-Display 
QCFlow offers an auto-display function that allows operators to visually 
verify documents without touching the keyboard or mouse.  Once started, this 
process will automatically display each page of the document (full-page mode) 
or thumbnail view of pages (thumbnail mode) for a specified number of 
seconds.  As described in Chapter 6 – System Options, you can alter the 
system options to specify how many (if any) pages should be skipped and how 
long each page should be displayed for. 

Auto-Display can be started by selecting Start Auto-Display from the Data 
Group menu, clicking on the  toolbar icon, or pressing F5 on your 
keyboard.  Once started, Auto-Display can be paused by selecting Stop Auto-
Display from the Data Group menu, clicking on the  toolbar icon, or 
pressing Esc on your keyboard. 

 

Tagging Pages and Documents 
QCFlow allows operators to manually tag pages and documents with custom 
tags.  This is useful if an operator needs to visually inspect pages and tag 
pages for rescan in PaperFlow.  Tagging can be done in either full-page or 
thumbnail mode.   

Tagging Pages and Documents in Thumbnail Mode 
To tag pages or documents in thumbnail mode: 

1. While in thumbnail mode, hold down the Ctrl key and click on the 
pages (or pages within the documents) you wish to tag (or use the 
Shift key to select a range of pages). 
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2. Select Tag Pages (or Tag Documents) from the Edit menu, click the  
(or ) toolbar icon, or hit your “T” (or “Ctrl+T”) key on your 
keyboard to tag the selected pages (or documents). 
QCFlow will display a cumulative list of current tags for all of the selected 
pages (or documents). 

 

 
Figure 5-5:  Tag Pages 

 

3. Select the tags that you wish to have applied and choose the “>>” 
button.  If you type a new tag in and add it, it will automatically be 
saved for future use to tag other pages (or documents). 

4. Select Save to apply all of the tags listed in the Current (Cumulative) 
Tags to every page (or document) that has been selected. 

 

Tagging Pages and Documents in Full-Page Mode 
To tag pages or documents in full-page mode: 

1. While in full-page mode locate the page (or a page within the 
document) you wish to tag. 

2. Select Tag Pages (or Tag Documents) from the Edit menu, click the  
(or ) toolbar icon, or hit your “T” (or “Ctrl+T”) key on your 
keyboard to tag the selected pages (or documents). 
QCFlow will display a list of current tags for the selected page (or 
document). 
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3. Select the tags that you wish to have applied and choose the “>>” 
button.  If you type a new tag in and add it, it will automatically be 
saved for future use to tag other pages (or documents). 

4. Select Save to apply all of the tags listed in the Current (Cumulative) 
Tags to the page (or document) that has been selected. 
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Chapter 6 – System Options 

Overview 
QCFlow’s system options allow you to specify information about how the 
system displays thumbnails and performs its Auto-Display functions. 

 

 
Figure 6-1:  System Options 

 

Thumbnail Options 
Width:  Specifies the width of each thumbnail (in Pixels). 

Height:  Specifies the height of each thumbnail (in Pixels). 

Number to Display:  Specifies the number of thumbnails to load at once. 

 

Automated Display Options 
Interval:  Specifies the number of seconds before displaying the next image or 
the next thumbnail group. 

# Pages to Skip:  Specifies the number of pages to skip between displayed 
pages.  For instance, a value of “1” would display every other page.  A value 
of “0” will display every page. 
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Chapter 7 – System Logs 

Overview 
Whenever QCFlow executes an automated process, it automatically saves a 
log of the process in the C:\QCFlow\QC Job Logs directory.  A new log is 
created each day for each project within a data group. 

 

Viewing System Logs 
To view the system logs: 

1. From the QCFlow Main Screen, with a data group open, select View 
Logs from the Data Group menu or click on the  toolbar icon. 
QCFlow will prompt you for the type of logs that you wish to view. 

 

 
Figure 7-1:  View Logs 
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2. Select the type of log that you wish to open and select the View button. 
QCFlow will open a text editor to display the appropriate log file. 

 

 
Figure 7-2:  Sample Log File 
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Chapter 8 – Security 

Overview 
QCFlow uses user/group level security that integrates with PaperFlow (DSI’s 
document capture software) to limit access to system functionality on a per-
project basis.  In other words, you can create user accounts and rather than 
assign each of those users rights to a project, you can add those users to a 
group and assign the group rights to a project.  Persons changing security 
options must be logged in as an administrator. 

 

Working with Users 
Users represent each individual user of the QCFlow system.  Although you 
can assign project rights to groups, you can also assign project rights to 
individual users as well.   

Creating a User 
To create a user: 

1. While logged in as an administrator, select Security from the 
Administration menu. 
The User/Group Security screen is displayed. 
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Figure 8-1:  User/Group Security 
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2. Select the Add button under the User list. 
The User Information screen is displayed. 

 

 
Figure 8-2:  User Information  

 

3. Enter the name of the new user. 

4. If desired, enter the password of the new user, then re-enter the 
password to confirm that you have typed it correctly.  Note that the 
password will be hidden by the "*” character as you type.  Passwords 
are case-sensitive. 

5. If the user is to be a system administrator (i.e. a user that can 
configure and purge any part of the system), select the Administrator 
checkbox. 

6. If the user is to have full access rights to all projects, select the All 
Rights on All Projects checkbox. 

7. If the user is to be able to change their own password, select Allow 
Password Changes. 

8. If the user is to be allowed to make modifications to project setups, 
select Allow Project Setup Changes. 
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9. Select Save to create the new user. 
The new user will be added to the User list. 

Editing an Existing User 
To edit an existing user: 

1. While logged in as an administrator, select Security from the 
Administration menu. 
The User/Group Security screen is displayed. 

2. Select the user you wish to edit and choose the Edit button under the 
User list. 
The User Information screen is displayed showing the selected user’s 
information.   

3. Change the desired user information. 

4. Select Save to save the changes. 

Deleting an Existing User 
To delete an existing user: 

1. While logged in as an administrator, select Security from the 
Administration menu. 
The User/Group Security screen is displayed. 

2. Select the user you wish to delete and choose the Remove button under 
the User list. 
QCFlow will confirm that you wish to remove the user from the system. 

3. Select Yes to remove the user or No to cancel the operation. 
The user will be removed from the system. 
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Working with Groups 
Groups allow you to select similar users and assign rights to those users all at 
once. 

Creating a Group 
To create a group: 

1. While logged in as an administrator, select Security from the 
Administration menu. 
The User/Group Security screen is displayed. 

2. Select the Add button under the Group list. 
The Group Information screen is displayed. 

 

 
Figure 8-3:  Group Information Screen 

 

3. Enter the name of the new group. 

4. Select the users in the Non-Member list that you wish to have in the 
group and select the < < button to add them to the Group Members 
list.  You can also select the users in the Group Members list and 
choose the > > button to remove them from the group. 
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5. If the members of the group are to have full access rights to all 
projects, select the All Rights on All Projects checkbox. 

6. If the members of the group are to be allowed to make modifications 
to project setups, select Allow Project Setup Changes. 

7. Select Save to create the new group. 
The new group will be added to the Group list. 

 

Editing an Existing Group 
To edit an existing group: 

1. While logged in as an administrator, select Security from the 
Administration menu. 
The User/Group Security screen is displayed. 

2. Select the group you wish to edit and choose the Edit button under the 
Group list. 
The Group Information screen is displayed. 

3. Update the group information as desired. 

4. Select Save to save the changes. 

 

Deleting an Existing Group 
Deleting a group will only delete the group rights.  The individual users will 
continue to exist, but without any of the rights assigned to them in the group. 

To delete an existing group: 

1. While logged in as an administrator, select Security from the 
Administration menu. 
The User/Group Security screen is displayed. 

2. Select the group you wish to delete and choose the Remove button 
under the Group list. 
QCFlow will confirm that you wish to remove the group from the system. 

3. Select Yes to remove the group or No to cancel the operation. 
The group will be removed from the system. 
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Assigning Rights 
QCFlow offers the ability to limit access to the different functionality within a 
project.  Although you can assign rights to users, making a user an 
administrator automatically grants that user all rights to all projects.  Always 
keep in mind that rights are accumulative - you accumulate individual rights, 
as well as all rights assigned to any group of which you are a member. 

 

 
Figure 8-4:  User Rights 

 

View Documents:  Grants the ability to view images within the project. 

Scan Documents:  Grants the ability to scan additional images into the 
project (PaperFlow). 

Print Images:  Grants the ability to print images within the project  
(PaperFlow). 

Export Documents:  Grants the ability to export documents within the 
project (PaperFlow). 

QC Documents:  Grants the ability to access quality control operations 
within QCFlow. 

Alter Images:  Grants the ability to perform any image altering operations 
such as re-save, invert image, etc. within the project. 

Index Documents:  Grants the ability to perform indexing operations 
within the project. 
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Import Documents:  Grants the ability to import images (in any fashion) 
within the project (PaperFlow). 

Post-Processing:  Grants the ability to begin the post-process within the 
project (PaperFlow). 

Full-Page OCR: Grants the ability to process documents through 
OCRFlow™, a full-text indexing engine. 

Note:  Only system administrators may purge data groups. 

 

To assign or change rights for a user or group: 

1. While logged in as an administrator, select Security from the 
Administration menu. 
The User/Group Security screen is displayed. 

2. Select the user or group you wish to assign rights to and select the Edit 
button. 
The User or Group Information screen is displayed. 

3. If assigning rights to a group, select the Group Rights button in the 
Group Information screen.  If assigning rights to a user, select the 
User Rights button in the User Information. 
The User Rights screen is displayed. 

4. Select the department/client whose project you are changing the rights 
for in the Department / Client list. 
A list of projects for the selected client will be filled in the Project list. 

5. Select the project you wish to change the rights for. 
The current rights for that project will be displayed. 

6. Select the rights you wish to grant to the user or group. 

7. Select the Save button to save the new settings. 

8. Repeat steps 4 through 7 for any remaining projects you wish to grant 
rights to. 
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Appendix A – System Hotkeys 

 Scan/Index Functions  View Functions    
Hotkey Function Hotkey Function 
Left Arrow Selects previous thumbnail Right Arrow Selects next thumbnail 

F5 Start Auto-Display Escape Stop Auto-Display 

Enter Advance Forwards Ctrl+Enter Reverse Backwards 

Delete Delete Page Ctrl+Delete Delete Document 

R Rotate/Rotate and Resave V Resave Page 

Ctrl+Insert Insert Document Break Ctrl+R Remove Document Break 

T Tag Page(s) Ctrl+T Tag Document(s) 

Ctrl+C Select Pages for Move Ctrl+V Paste Selected Pages 

Home First Page Ctrl+Home First Document 

Page Up Previous Page Ctrl+Page Up Previous Document 

J Jump to Page Ctrl+J Jump to Document ID 

Page Down Next Page Ctrl+Page Down Next Document 

End Last Page Ctrl+End Last Document 

W Scale to Width H Scale to Height 

I Image Information Ctrl+I Perform Index QC 

Space Toggle Image/Thumbnail View   
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Appendix B – Command Line Options 

Overview 
QCFlow offers a command line interface that allows an external application to 
launch QCFlow, log into the system, and open the appropriate data group. A 
sample command line may look like the following: 
C:\Program Files\Digitech Systems\QCFlow\QCFlow.exe /USER:ADMIN /PASSWORD:t2Year 
/DGPATH:G:\DATAGRP\DATAGRP.MDB /DGPROJID:2 

 

Command Line Options 
USER: Specifies the user to log in as. (Required) 

PASSWORD: Specifies the password to use to log into the system. 
(Required) 

DGPATH: Full Path to the data group database to be opened. (Required) 

DGPROJID: If the data group contains more than one project, this specifies 
which project to open (Optional). 
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